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ABSTRACT 

 

Quantifying Mass Sediment Movement in Deer Creek 

Reservoir During Spring Runoff and  

Potential Water Quality Impacts 

 

Colin Rodger Ricks 

Department of Civil and Environmental Engineering, BYU 

Master of Science 

 

The accurate prediction of water quality is essential for management of reservoirs used 

for drinking water supply.  Since algae are a major source of taste and odor problems in drinking 

water, understanding and controlling algal growth and production is an important task.  Deer 

Creek Reservoir supplies drinking water for over one million people in northern Utah and has 

been highly eutrophic in the past. Despite major reductions in external nutrient loading, 

including phosphorus, seasonal algal blooms in Deer Creek have not decreased to desired levels. 

Resuspension of sediment has been suggested as a potential source of internal nutrient loading 

for water bodies (including reservoirs in the Utah/Wyoming area) and may be responsible for 

delays in water quality improvement.  

I investigated sediment deposition and resuspension rates at the upper end of the reservoir 

and evaluated these sediments as a possible internal source of phosphorus. Sonar and GPS 

systems were used to make measurements of recently deposited sediment in the submerged 

Provo River delta of Deer Creek Reservoir during the period of May, June, July, and August 

2011. ArcGIS 10 was used to interpolate survey points and calculate sediment volume changes, 

including areas of deposition and erosion. These data were used to develop approximate 

sedimentation rates for the soft sediment – which is most susceptible to resuspension during 

reservoir drawdown. I used previously measured field phosphorous concentrations in the 

sediment to estimate if these processes could affect reservoir phosphorous concentrations.  

The study used two survey areas, a small area near the Provo River inlet early in the year, 

and an extended larger area starting on June 23
rd

. I found that sediment volume in the smaller 

study area was increasing at a rate of 27-109 m
3
/day during the spring season. Data show that 

rates are slightly correlated with flow and reservoir elevation.   

Typically by August, Deer Creek reservoir would have been drawn down 2 to 4 m. 

However, due to a heavy snow pack in 2011, Deer Creek reservoir was not drawn down. When 

the reservoir is drawn down, the sediments in the upper region of the delta, where the survey was 

conducted, will be resuspended and deposited lower in the reservoir. These processes will likely 

result in releasing the phosphates currently bound to the sediment into the water column. Based 

on previous measurements of readily soluble phosphates bound to the sediment, this 

resuspension could release between 80 and 230 kg of phosphorus from the study area into the 

water column during critical times during the warm months–conditions well suited for algal 

growth. This amount of phosphorus, while an upper bound of what could be expected under 

actual field conditions, could raise phosphorus concentrations in the survey area by as much as 

0.38 mg/L. The potential P (80-230 kg) release could account for 14%-42% of the TMDL. This   



 

  



 

is a potentially significant amount, especially if released during the critical late-summer period, 

and warrants more detailed study.  
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1 INTRODUCTION 

1.1 Problem Statement and Hypothesis 

Deer Creek Reservoir (DCR) supplies drinking water to a large population in northern 

Utah as well as meeting agricultural, flood control, recreational, and ecological needs. In the 

1980s, the reservoir was identified as highly eutrophic due to significant nutrient inflows. With 

the establishment and implementation of nutrient controls, water quality has improved and the 

reservoir is currently classified as mesotrophic, but efforts are continuing to further improve 

water quality (PSOMAS 2002). Significant algal blooms still occur and are detrimental to the 

health of the reservoir and water quality. These algal blooms affect the ability of water treatment 

to control water quality and cause taste and odor issues (and potentially more serious problems).  

An ongoing project by the Deer Creek research group at BYU is gathering data and 

performing analysis with the aim of understanding the reservoir processes that affect water 

quality in DCR. One specific area of study is processes that drive nutrient availability – 

especially those related to internal nutrient cycling. One of the processes that could be significant 

is sediment resuspension. This process could reintroduce phosphorus (P) to the water column 

during summer months when it can have the largest impact on algal growth rates and volumes. 

Resuspension is likely caused by re-cutting of soft sediments deposited in the sediment deltas in 

the spring, then resuspended during reservoir drawdown in the summer. The purpose of my 
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research is to determine if resuspension of sediment in the upper portion of DCR could be a 

significant internal source of P and to quantify this process to the extent possible. I did this by 

measuring and extrapolating sediment deposition rates, then estimating P mass in the sediment 

based on earlier field measurements. This approach to estimate amount of P that could be 

released represents the upper limit of the P that could be introduced into the water column from 

resuspension of the sediment delta.  
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2 THEORETICAL BACKGROUND 

2.1 Deer Creek Reservoir 

This section describes the reservoir and study location, including some historical water 

quality information.  

2.1.1 Basic Information  

Deer Creek Reservoir (Figure 2-1) is located 7 miles southwest of Heber City, Utah and 

used primarily for drinking water and irrigation purposes (BOR 2009). With a capacity of 185 

Mm3 (150,000 acre-ft), the reservoir provides culinary water for over one million people in Salt 

Lake, Utah, and Wasatch counties (EPA 2009). There are four primary inflows for the reservoir: 

Provo River, Main Creek, Snake Creek, and Daniels Creek (see Figure 2-2). Of these, the Provo 

River/Snake Creek system, which enters at the north end, is the most significant (PSOMAS 

2002). The maximum water surface elevation is 1652 m (5417 ft) and the drainage area is 1450 

sq km (560 sq mi) (BOR 2009).  

The reservoir was created in 1941 by the construction of an earth-fill dam at the southern 

end. The depth at the deepest point when full is 35 m (115 ft). Annual precipitation in the 

watershed is 41-102 cm (16-40 inches) and the land use is varied, with most of the watershed 

lands owned by the United States Forest Service (USFS) and the Bureau of Land Management 

(BLM). Private land in the watershed is primarily agricultural, with some suburban and urban 
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areas near Heber. Beneficial uses defined by the state include culinary water, swimming, 

boating, cold water game fish (and organisms in their food chain), and agricultural uses (UDWQ 

2004). 

 

Figure 2-1: Deer Creek Reservoir-Upper End (MWDSLS 2009) 

2.1.2 Water Quality  

Because DCR is used extensively for culinary water supply, understanding and predicting 

processes that affect the water quality is important for reservoir management and planning 

treatment methods. The Utah Division of Water Quality (UDWQ) determined the overall quality 

of the water in DCR to be good. However, P and dissolved oxygen (DO) still exceed State water 

quality standards. This is a concern because high P levels can lead to significant algae growth 

affecting both DO and potentially causing problems at water treatment plants (PSOMAS 2002; 

MWH 2005; EPA 2009).  



5 

 

Figure 2-2: Deer Creek Reservoir and Study Area 

In the past, the reservoir was highly eutrophic with heavy blooms of blue-green algae. 

TMDLs were implemented in the 1970s and 1980s and the water quality improved as point and 

nonpoint sources of nutrients were eliminated, reducing nutrient inflows to the reservoir. 

However, heavy late-summer algal blooms still occur, particularly at the north end of the 

reservoir near the Provo River mouth. Algal byproducts cause significant taste and odor 

problems in culinary water that require expensive methods to treat, so reducing or eliminating 

algae is a high priority for local water users (PSOMAS 2002; MWH 2005; EPA 2009). 
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2.1.3 Local Sediment Studies 

While many studies have shown the importance of internal loading as a source of P to 

reservoirs, Messer & Ihnat (1983) state that: 

[V]irtually no information is available on the extent to which internal phosphorus loading 

is important in reservoirs in the Intermountain West, or on the factors controlling 

phosphorus uptake or release in these sediments. 

During the 1980’s, a series of sediment studies aimed at understanding the sediment-

water-P interaction was conducted on large reservoirs in the Intermountain West, including DCR 

(Messer 1983). They found that the sediment surface becomes anaerobic during the same time 

period when algal blooms occur due to decomposing biomass. A number of the P phases in the 

sediments are significantly more soluble in anoxic conditions, which cause P to be released from 

the sediment. The algal blooms conceptually create a feedback loop, where algae create an 

anaerobic environment conducive to sediment P release, spurring additional algae growth, with 

the cycle continuing until fall turnover.  

A second process that could provide P from internal sources is resuspension of soft (or 

hard) sediments deposited in the delta areas. Resuspension of the soft sediments would occur in 

the critical late summer period due to reservoir drawdown to support agricultural and culinary 

requirements. A recent study (Casbeer 2009) of sediments in the DCR Provo River delta 

confirmed large quantities of soluble P in the delta sediments which would directly contribute P 

to the water column during resuspension. Casbeer (2009) measured P in several forms including 

those soluble under normal reservoir water column conditions, as well as forms only soluble 

under anoxic conditions. From sediment samples taken in the exposed delta during a time of very 

low water levels, the average concentration of water soluble P was determined to be 9.19*10 

mg/kg sediment (Casbeer 2009). 
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2.2 Phosphorus, Algae, and Sediments 

While there are multiple factors involved in algae production, dissolved P is usually 

regarded as the most important (Schindler 1974; Søndergaard, Jensen et al. 2003). Although 

there are many possible sources of P to a water body (PSOMAS 2002), this study focused on 

investigating resuspended sediment as a source of P to DCR. Temperate reservoirs, including 

DCR, are generally P limited for algal growth. This means that any additional P loadings result 

in significant algal growth. This is in contrast to additional nitrogen loadings, another algal 

nutrient, which have minimal impacts because the reservoir is not nitrogen limited (Lewis Jr 

1996; Lewis Jr 2000). 

2.2.1 Nutrient Recycling and Sediment Resuspension 

Depending on the amount of P and dissolved oxygen in the water, deposited sediment can 

act as either a source or a sink (Mayer and Gloss 1980; UDWQ 2004). Lakes and rivers act as 

nutrient traps, accumulating much of the external nutrient load in internal P-reservoirs. These 

accumulated nutrients are generally found in the organic sediments of lakes and may represent 

years of external loading (Graneli 1999). When external loadings are reduced (changing the 

equilibrium concentrations), phosphorus can be desorbed from deposited sediments and 

introduced to the water column. This can continue for many years, counteracting the reductions 

in external loading (Boström, Andersen et al. 1988; Graneli 1999; Gächter and Müller 2003). 

Morris & Fan (1998) note the importance of sediment as a source of P: 

While most phosphorus in natural lakes is associated with seston, in reservoirs 

experiencing significant sediment loads much phosphorus may be associated with 

sediment, primarily the fine fraction that has a large surface area in relation to mass. 

My research focused on identifying the amount and describing the movements of these 

fine sediments and producing a general analysis to quantify the potential upper limit for P release 
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that could occur during resuspension. I quantified the amount of sediment deposited in the upper 

reaches of Deer Creek Reservoir that could potentially move further down the reservoir during 

drawdown. Drawdown occurs during the warmer months, and any P released during this period 

would have significant impacts on algae growth.  

Previous studies in shallow water bodies have identified sediment resuspension as a 

release mechanism for P (Koski-Vähälä 2001). Koski-Vähälä noted that: 

The P release from the solid phase to the water column is influenced by many biological 

and physico-chemical factors, and resuspension is a mechanism that may influence the 

internal P loading by mechanically mediating the P exchange between suspended 

material and the water column. In order to understand factors contributing to internal P 

loading, the effect of the resuspended sediment on the P fluxes in lakes must also be 

assessed.  

While P sorbed onto deposited particles can reach equilibrium with the P concentration in 

the water column, resuspended sediments encounter different environmental conditions which 

might cause increased P release (Pettersson 1998). Previous studies have concluded that the 

sediment:water column ratio is much higher in shallow water and the potential influence on P 

concentrations is greater than for the rest of the reservoir (Mayer, Ptacek et al. 1999; 

Søndergaard, Jensen et al. 2003).  

In this study, the precise source of resuspension is not investigated, although possible 

sources could include fish (Breukelaar, Lammens et al. 1994), wind/waves (Søndergaard, Jensen 

et al. 2003), or reservoir/river stage changes – which I am assuming to be the major mechanism 

in Deer Creek in terms of volume. However, because sediments in shallow waters are more 

susceptible to wind/wave action, water level, and discharge changes than those in deep water 

(Sakai, Murase et al. 2002), we focused on these potential causes of resuspension. In the case of 

Deer Creek, annual draw down for water user exposes a significant portion of the sediment delta, 

potentially resuspending sediments deposited during spring runoff. This study is focused on 
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quantifying both the amount and rate of soft sediment deposition in Deer Creek Reservoir during 

full reservoir conditions and high spring inflows. This is then used to estimate the upper limit for 

the mass of P that could be potentially resuspended and its effect on reservoir P concentrations.  

The upper portion of DCR is highly susceptible to sediment resuspension because of the 

shallow depth and the influence of the Provo River which enters the reservoir in this area. Soft 

sediments are typically deposited in the spring when water levels are high along with higher 

inflow volumes that carry high suspended sediment loads. As the reservoir elevation and river 

stage change, we propose that changes in shear stresses cause resuspension of these soft 

sediments and movement from the upper portion of the river channel, releasing sediment-bound 

P into the water column during this movement. As the velocity slows again farther in the 

reservoir, the sediment is re-deposited. We are particularly interested in the soft, non-compacted 

sediments. These sediments are easily resuspended and, we hypothesize, operate on an annual 

cycle with resuspension and deposition occurring in the spring and early summer followed by 

compaction through the remainder of the year. In the late summer during reservoir drawdown, 

these uncompacted sediments are particularly susceptible to resuspension, where they would 

release P into the water column before being re-deposited lower in the reservoir to undergo 

compaction. Our objective is to measure the volume and rate of soft sediment deposition/erosion 

in the upper portion of the reservoir that will experience the most drastic changes in water depth 

and to quantify the potential P release in the summer months. In this area, we hypothesize that a 

large portion of the soft sediments will be resuspended as water levels are reduced, being 

transported further into the reservoir.  
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2.3 Measuring Submerged Features 

In order to quantify the sediment deposition rates of soft sediment over time, regular 

surveys of the channel bottom were performed using a sonar system mounted on a survey boat. 

We used dual-beam sonar which distinguishes between soft and hard sediment. The high 

frequency beam is reflected from the surface of the soft sediments, while the low frequency 

beam penetrates the soft layer and is reflected from the compacted or hard sediments. Since these 

measurements are co-located we can theoretically use this difference in depth to measure the 

thickness of the soft sediment layer and monitor its change over time. This proved to be more 

problematical than originally thought. These problems will be discussed in a later section.  

2.3.1 Sonar Theory of Operation 

Sonar was developed during World War II to detect enemy submarines and is used to 

locate objects underwater. Originally it was an acronym denoting SOund Navigation And 

Ranging but through common usage is now viewed as a noun. Sonar works by emitting a ―ping‖ 

of sound from a transducer and measuring the reflection time. Since the speed of sound in water 

is fairly constant (about 1500 m/s), the depth may be easily determined by measuring the ping 

travel time (Figure 2-3).  

A transducer sends and receives the pings, which are converted to a digital signal and 

displayed and recorded on a computer. Individual measurements are referred to as soundings 

(HYPACK 2011). Sonar pings are transmitted at a specific pitch (frequency). High frequency 

gives better resolution while low frequency penetrates to greater depth, through weeds, or into 

sediments. Regarding choice of frequency, Hypack (2011) states: 

The higher the frequency, the higher the reflectivity of the material. One of the 

drawbacks with higher frequency (200+KHZ) transducers is they reflect off almost 
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anything. This includes vegetation, air bubbles, fish bladders, and suspended sediments. 

A lower frequency transducer (e.g. 24KHZ), although slightly less precise, will allow you 

to pass through some of these materials to actually track the bottom. Over a soft (mud, 

sand, silt) bottom, a low frequency transducer will generally provide deeper depths than a 

high frequency transducer. Over a hard (rock) bottom, the two transducers should 

produce almost the same depth. 

By using a dual-frequency sonar system, both the soft and hard bottom can be identified. 

This method is a common method for measuring sediment thickness (Dunbar, Higley et al. 

2002). As noted in the quote from Hypack (2011), the high frequency ping is potentially 

reflected from the soft bottom fluff in sediment deltas. However, by comparing the sonar returns 

with physical measurements, we discovered that at DCR, the high frequency tracks the bottom 

while the low frequency is reflected off an undetermined denser layer beneath the sediment 

surface.  

 

Figure 2-3: Sonar Theory 
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2.3.2 Sonar in Sediment Studies 

High resolution sonar has already been identified as a tool to quantify reservoir 

sedimentation (Dunbar, Higley et al. 2002). Most applications deal with measuring 

sedimentation for updated reservoir-capacity charts or marine channel dredging. The US Natural 

Resources Conservation Service (NRCS) has used sonar to measure the thickness of deposited 

sediment layers at flood control dams (Dunbar, Higley et al. 2002) and the USGS routinely uses 

sonar to monitor shipping channels (Sterling 2003). Similar short time period studies monitoring 

contaminated sediments have also be performed using sonar (Rukavina 2001). 

2.3.3 GPS Theory 

A Global Positioning System (GPS) uses orbiting satellites to transmit position signals. A 

ground receiver connected to 4 or more satellites can triangulate its position within about 10 

meters and can be used in conjunction with sonar to map the bathymetry of a water body. The 

GPS communicates with the sonar to provide position data for each sounding (HYPACK 2011).  

2.3.4 Achieving Higher Resolution 

Typically, stand-alone GPS receivers have a potential error of about 10 meters. 

Differential corrections can reduce the GPS satellite error to about 2 meters or less (Trimble 

2007). Some surveys use RTK GPS positioning or motion reference units (MRUs) to compensate 

for boat motion and obtain very precise, sub-centimeter horizontal and vertical measurements. I 

attempted to use RTK equipment for this research to more precisely measure the absolute 

elevation of the sediment surfaces.  

However, since we were unable to get an RTK GPS to work with our sonar equipment, 

we used a differential corrected GPS signal which we observed to be accurate to about 1.5 
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meters. For vertical corrections, we identified an area of the reservoir near the shore with a hard 

bottom that did not change in elevation over the course of the survey. For each survey date, we 

determined the vertical correction to apply to the data by matching this section elevation. This 

approach allowed us to map changes in bottom elevation over the course of the survey and 

determine sediment deposition and erosion rates. 
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3 MATERIALS AND METHODS 

3.1 Equipment 

This section contains a brief description of the equipment used to collect and process 

data. This includes both the hardware and software used to collect and process the data.  

3.1.1 Boat 

A 6.7 m (23 ft) pontoon boat (Figure 3-1) was used to take measurements. The pontoon 

design provides a stable platform that minimizes pitch and roll—important in sonar mapping 

applications. The turning radius of the boat is about 7.6 m (25 ft) so survey lines were planned 

accordingly.  

3.1.2 Sonar 

The sonar equipment used included a dual-frequency transducer and an Echotrac CVM 

single-beam echo sounder, both manufactured by ODOM Hydrographic. The transducer 

produced signals at 48 kHz and 200 kHz. A laptop computer running Hypack 2011 and ODOM 

eChart was used to operate the equipment and record and process soundings. The resolution 

(footprint) of the sonar is about 0.8 ft
2
 at a 30 ft depth with accuracy of 0.01 ft +/- 0.1% of the 

depth (HYPACK 2011). Figure 3-2 shows some of the sonar equipment.  
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Figure 3-1: Boat With Transducer in Horizontal Position 

 

Figure 3-2: Laptop and Echotrac CVM 

Because the speed of sound in water depends on temperature and density, the sonar was 

calibrated each trip to correct for this. An ODOM DigiBar Pro was used to calibrate the sound 

velocity for the specific water conditions each site visit. For each survey, a sound velocity profile 

was recorded and used to correct the raw soundings. 
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After one month of surveying, questions arose about the nature of the material measured 

by the sonar system. Originally we assumed that the high frequency reflected off a ―fluff‖ layer 

and the low frequency reflected off an unchanging dense layer beneath it. By comparing the 

sonar readings with physical measurement, we discovered that the high frequency reflected off 

the bottom and the low frequency penetrated to some unknown layer in the sediment below that. 

We were not able to characterize the upper sediments penetrated by the long-wave sonar and 

these features are outside the scope of my research and not important to annual sediment 

processes. We used the reservoir bottom elevation, as determined by the high frequency sonar 

measurement to map elevation changes over the course of the field surveys.  

3.1.3 GPS 

A Trimble DSM 232 GPS receiver is mounted internally in the Echotrac CVM with the 

antenna attached to the pole above the transducer. This unit is capable of receiving differential 

GPS signal corrections in real time. Some units can receive high resolution RTK signals when 

attached to a radio receiver, but our unit is not currently RTK capable. The horizontal error of the 

differential GPS signal, which can be up to 2 meters, is typically 1 meter or less for this unit 

(Trimble 2006).  

3.1.4 Other Equipment 

A horizontal Van Dorn sampler was used to collect one liter water samples at the secchi 

depth. Samples were stored in a cooler while in the field. The samples were transferred to a 

freezer at 4 °C until lab tests could be conducted, usually within 3 days. From the water samples, 

phosphate concentrations were measured using a Hach DR-5000 spectrophotometer. A Hach 

Hydrolab DS-5 was used to measure water quality parameters on several trips.  
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3.1.5 Processing and Analysis Tools 

Hypack 2011 surveying software was used to record and process the raw data. ArcGIS 10 

was used to view processed data and calculate sediment volume changes over time. Hypack has 

some custom TIN-based tools for computing volumes, but I did not find these as easy to use or 

as accurate as the ArcMap tools, so I used ArcMap for all my volume calculations.  

3.2 Methods 

The basic processes used for this work are described in this section. Detailed step-by-step 

instructions are provided in the appendix. Originally, site visits were planned twice per week on 

Mondays and Thursdays. However, equipment difficulties and unpredictable spring weather 

cancelled several trips and consequently data were not collected uniformly in time. In addition, 

data showed that changes were relatively slow, and that bi-weekly surveys were not required, 

though occasionally they were still performed. A total of 16 surveys were performed on the dates 

highlighted in Table 3-1. The darker color indicates that the larger area was surveyed. 

Water samples were collected at the locations indicated in Figure 3-3 and later analyzed 

in the laboratory for P concentration. Streamflow and reservoir elevations were obtained from 

the USGS and Central Utah Water Conservancy District (CUWCD) for each trip. Satellite 

imagery from 2004 when the reservoir was very low was used to locate the main channel and 

determine the area susceptible to exposure during drawdown. Starting on June 23rd, a larger area 

was surveyed to attempt to get a better picture of what was happening.  
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Figure 3-3: Trip Calendar 

Trial and error methods were used to determine the best planned line configuration for 

surveying the channel. For the first trip, we attempted to use cross sections that were 

perpendicular to the assumed channel location. These lines proved very difficult to survey in the 

field. For later trips, we adopted a grid of parallel lines to cover the channel area as shown in 

Figure 3-4. Thirty-seven ―horizontal‖ lines about 500 ft long were spaced 15.25 m (50ft) apart. 

The five vertical lines were spaced 30.5 m (100 ft) apart and were used to compensate for the 

fact that the cross sections were no longer parallel to the channel. One line was also placed along 

the channel centerline. The area enclosed by the survey was 111,000 m
2
.  
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Figure 3-4: Planned Lines Superimposed Over 2006 Image 

After reviewing the results up to June 20
th

, it seemed that there might be changes 

happening outside the survey area that we were not capturing. Starting on June 23
rd

, a larger area 

(1,210,000 m
2
) shown in Figure 3-3 was surveyed. Because the area is so much larger, the line 

spacing had to be adjusted to allow for a reasonable survey time. Consequently, the line spacing 

was adjusted as shown to have a smaller spacing near the river mouth and a larger spacing 

farther into the reservoir.   
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3.2.1 Data Collection 

3.2.1.1 Samples and Probe 

One liter water samples were collected from the locations shown in Figure 3-3. Phosphate 

tests using the spectrophotomer were performed 1-4 days after collection. Test results were 

stored in the BYU Deer Creek research group database. For the June 2nd trip, a water quality 

probe was dragged at a depth of ~1 m in the survey area during sonar measurements to collect 

spatial water quality data. These probe measurements were recorded continuously at 5 second 

intervals and plotted in ArcMap. Profile measurements were also made with the probe on July 

29th. 

3.2.1.2 Surveying 

Prior to each field trip, I reviewed the Hypack file for that day, which included the 

appropriate software settings and files. Part of that file included planned survey lines over the 

study area. During surveying, a real-time display of the boat position was displayed on the map 

(see Figures 3-4 and 3-5) along with the planned survey lines. This method ensured data were 

collected for all the areas needed. Ideally, each line would be surveyed within one boat width, 

but weather or other water users sometimes made this difficult.  

The sonar was operated at 200 kHz and 48 kHz, and the resulting measurements were 

recorded as Depth1 and Depth2 respectively. We found that keeping the boat at a constant speed 

between 4 and 6 mph worked well. Each survey resulted in 100,000-200,000 points collected. 

These were later filtered and the number reduced in post processing (see section 3.2.2).  
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Figure 3-5: Real-Time Display of Survey 

3.2.1.3 Other 

Reservoir elevations were recorded at the dam, which is approximately 8 km from the 

sample site. I assumed the surface of the reservoir was flat (the water surface elevation at the 

dam was the same as the water surface elevation at the survey area) and subtracted the sonar 

depth to obtain an elevation for the sediment surface. Stream gage data was obtained from the 

USGS National Weather Information Service (NWIS) stream gage on the Provo River near 

Charleston (#10155500) and Snake Creek near Charleston (#10156000).  
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Figure 3-6: Surveying 

3.2.2 Data Processing 

This section provides a general outline of the data processing steps. More detailed 

instructions are provided in the Appendix.  

3.2.2.1 Quality Control Sonar Measurements 

Raw measurements stored in Hypack were checked for quality and converted to a 

standard format before further analysis. This was accomplished using the Hypack Single Beam 

Editor. First, sound velocity corrections were applied and spikes were filtered. Every 5
th

 point 
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was selected and the lines were smoothed based on the nearest 32 points. Figure 3-7 and Figure 

3-8 show this process. 

 

 

Figure 3-7: Hypack Single Beam Editor-Raw Soundings 
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Figure 3-8: Hypack Single Beam Editor-Edited Soundings 

3.2.2.2 Excel Processing 

After processing the raw files in Hypack, the results were exported to Excel, which was 

used to create a file readable by ArcGIS. During this process, I subtracted Depth 1 from Depth 2 

to get thickness, and subtracted the depth from the water surface for that day to get an elevation. 

The units were converted to meters and exported as a .csv file. See Figure 3-9 for a screen 

capture of this step. While I calculated a sediment thickness using Depth 1 and Depth 2 this 

value was not used in the analysis because, as noted, the character of the sediment measured by 

the long-wave beam was not applicable to my research. 
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Figure 3-9: Excel Table 

3.2.2.3 ArcGIS Processing 

Figure 3-10 below shows the basic steps involved in this process.  

 

Figure 3-10: Processing Steps 

The cleaned data, consisting of points with location and thickness fields, were added to 

an ArcGIS map document. To compute volumes, I needed to create a surface from these points. 

While multiple methods were attempted, IDW interpolation in the Geostatistical Analyst 

extension provided the best results for this survey (based on a visual analysis of the results). A 

2003 study comparing spatial interpolation methods for hydrographic applications recommended 

spline interpolation (Sterling 2003), but I was not able to achieve reasonable results from the 

spline interpolation in ArcMap, possibly because of the relative complexity of the submerged 

Provo River channel.  

The interpolated grids which defined the surface of the sediment were masked so each 

grid included the same area. Standard locations were selected (see Figure 3-11) and used to 

Import 
points 

Interpolate 
points 

Get 
profiles 

Adjust 
surfaces 

Compute 
volumes 
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create a profile graph of the bottom using the 3D Analyst extension. The lines were chosen 

because they corresponded as close as possible to planned survey lines, which minimized 

interpolation errors. The profiles obtained from these lines were plotted in Excel and used to 

define the required adjustment of the surface elevations.  

 

 

Figure 3-11: Lines Used for Profile Plots 

As noted previously, an area not expected to change during the survey period was used as 

a base to provide vertical corrections to each survey. Because of various issues (the sonar unit 

does not stay at a fixed depth--it moves up and down with the boat), the surveys do not exactly 

match vertically in areas where we expect no changes. By comparing the profile plots, I was able 
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to adjust the lines to match at a point where no changes are expected. This same adjustment was 

then made to the surfaces in ArcMap. This method is not as accurate as using a RTK GPS, but 

we believe it gives reasonable results for this study.  

To map the changes in sediment, I used the May 28
th

 surface as a baseline (the earliest 

survey) and subtracted each surface from it. This provided surfaces of positive and negative 

elevation changes. These ―change‖ surfaces were used to calculate the volume of sediment with 

the Surface Volume tool.  

3.2.2.4 Phosphate Measurements 

Water samples were analyzed using a spectrophotometer in accordance with the 

laboratory standard operating procedures and Standard Methods for Examination of Water and 

Wastewater (Eaton and Franson 2005). Lab tests were performed within 4 days of sample 

collection. 
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4 RESULTS 

My results are presented in this section. Since my data consists of both large and small 

surveys, I clipped the large surveys to match the small survey area for analysis. However, I also 

analyzed the large area results separately.  

4.1 Elevation Maps 

Figure 4-1 and Figure 4-2 show examples of the elevation surfaces created in ArcMap. 

The channel is better defined for the early trips that used the higher resolution lines. These 

surfaces were used to calculate changes.  

4.2 Change Maps 

The following figures (Figure 4-3 andFigure 4-4) show the change from May 28
th 

using 

the preferred interpolation method (4 Sector IDW with 45 degree offset). Figure 4-5 shows the 

change from June 23
rd

 for the large area. These maps were created by comparing the elevations 

with the baseline (first survey). Statistics for the changes are listed in Table 4-1 and Table 4-2.  

 



30 

 
Figure 4-1: IDW (4 Sector, Offset) Elevation Map in the Small Area from the Small Survey 
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Figure 4-2: IDW (4 Sector, Offset) Elevation Map in the Small Area from the Large Survey 
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Figure 4-3: Small Area Change from 5/28 (a) 

 



33 

 
Figure 4-4: Small Area Change from 5/28 (b) 

 



34 

 
Figure 4-5: Large Area Change from 6/23 
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Table 4-1: Change Statistics (IDW 4 Sector Offset, Small Area) 

1 2 3 4 5 

Date Min Max Mean Std dev. 

5/31/11 -1.04 1.13 -0.04 0.10 

6/2/11 -1.52 1.29 -0.04 0.13 

6/9/11 -1.41 1.00 -0.10 0.13 

6/13/11 -1.32 1.02 -0.03 0.12 

6/16/11 -1.21 1.00 0.01 0.12 

6/20/11 -1.58 1.52 -0.03 0.21 

6/23/11 -1.10 1.68 -0.04 0.22 

6/27/11 -1.54 1.67 -0.04 0.28 

7/5/11 -1.11 2.18 -0.05 0.26 

7/7/11 -1.20 2.07 -0.05 0.26 

7/21/11 -0.96 2.15 -0.09 0.25 

7/27/11 -0.92 2.04 -0.11 0.25 

8/1/11 -0.99 2.01 -0.15 0.24 

8/4/11 -1.07 2.14 -0.13 0.25 

 

Table 4-2: Change Statistics (IDW 4 Sector Offset, Large Area) 

1 2 3 4 5 

Date Min Max Mean Std dev. 

6/27/11 -1.64 2.18 -0.01 0.26 

7/5/11 -1.62 2.19 -0.01 0.27 

7/7/11 -1.64 2.07 -0.11 0.27 

7/21/11 -1.45 2.69 0.04 0.27 

7/27/11 -1.29 2.19 0.01 0.27 

8/1/11 -1.23 2.22 0.08 0.26 

8/4/11 -1.31 2.17 0.00 0.26 

 

4.3 Profile Plots 

The following profiles were taken from line 1 and line 5 (shown in Figure 3-10) and 

adjusted by the amount required to match the lines at a point near the end of line 5 (Table 4-3).  
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Table 4-3: Surface Offsets 

Date 
Amount 

Adjusted, m 

5/28 0.00 

5/31 0.02 

6/2 -0.03 

6/9 -0.05 

6/13 -0.09 

6/16 -0.12 

6/20 -0.07 

6/23 -0.09 

6/27 -0.14 

7/5 -0.16 

7/7 -0.16 

7/21 -0.07 

7/27 -0.13 

8/1 -0.13 

8/4 -0.13 

8/8 -0.10 

8/15 -0.12 

8/18 -0.17 

8/22 -0.13 

8/25 -0.14 

 

Figure 4-6 and 4-7 shows the IDW 4 Sector Offset profiles for line 5, both original and 

adjusted, using all the survey dates. This was the preferred method for calculating the volumes.  
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Figure 4-6: Line 5, IDW 4 Sector Offset, Original 

 

Figure 4-7: Line 5, IDW 4 Sector Offset, Adjusted 
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The following figures show a comparison between adjusted profiles for each 

interpolation method for several dates and lines.  

 

Figure 4-8: Line 1 Profile Comparison, Jun 2 

 

Figure 4-9: Line 1 Profile Comparison, Jul 5



39 

 
Figure 4-10: Line 1 Profile Comparison, Aug 22 

 
Figure 4-11: Line 5 Profile Comparison, Jun 2 
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Figure 4-12: Line 5 Profile Comparison, Jul 5 

 
Figure 4-13: Line 5 Profile Comparison, Aug 22 
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4.4 Volume Comparison 

Several interpolation methods were tested to provide a rough estimate of the error involved with 

interpolating single beam sonar data. The methods tested were Diffusion, Spline with Tension, 

Natural Neighbors, Ordinary Kriging, IDW-1 sector, and IDW-4 sector. IDW-4 sector was the 

preferred method based on a visual analysis of the results. A volume comparison of the methods 

can be seen in Figures 4-14 and 4-15, showing the range of possible values.  

 

Figure 4-14: Volume Change Since 5/28 (Original) 
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Figure 4-15: Volume Change Since 5/28 (Adjusted) 

Using the slope of the linear trend line for volume, I calculated average sedimentation 

rates for each of the interpolation methods (Table 4-4) over an area of 111,100 m
2
 (small survey 

area).  

Table 4-4: Sedimentation Rates for Each Method 

 

Sedimentation Rate, 
m^3/day 

Sedimentation Rate, 
m^3/m^2 

  Original Adjusted Original Adjusted 

Diffusion 27 68 2.4E-04 6.2E-04 

IDW, 1 sector 50 97 4.5E-04 8.7E-04 

IDW, 4 sector offset 42 80 3.7E-04 7.2E-04 

Kriging 59 109 5.4E-04 9.8E-04 

Natural Neighbors 63 105 5.6E-04 9.4E-04 

Spline w/Tension 61 107 5.5E-04 9.6E-04 
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4.5 Water Surface Elevation and Discharge 

Figure 4-16 shows the water surface elevation (WSE) and combined Provo River/Snake 

Creek discharge for a 103 day period in 2010 and 2011. The discharge and WSE for 2011 is very 

different from 2010 because of the increased snowpack and late spring this year. Last year, the 

WSE would have been about 2 m lower than it is now (Aug 2011).  

 

Figure 4-16: Flow and WSE 

One uncertainty with the discharge data is that the USGS discharge values are marked 

―Provisional data subject to revision‖. As of August 2011, none of the measurements after 

February had been reviewed and approved for publication. Correlations with WSE and flow are 

shown below in Table 4-5. 
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Table 4-5: R
2
 Correlations Between Volume, WSE, and Flow 

 
WSE Flow 

  Original Adjusted Original Adjusted 

Diffusion 0.33 0.27 0.26 0.18 

IDW, 1 sector 0.40 0.30 0.27 0.20 

IDW, 4 sector offset 0.51 0.34 0.21 0.18 

Kriging 0.50 0.36 0.23 0.18 

Natural Neighbors 0.55 0.38 0.18 0.16 

Spline w/Tension 0.43 0.33 0.21 0.17 

  

These results indicate that over the survey period, there is some correlation between the 

sediment deposition rates and both river inflow and WSE. We did not expect a perfect 

relationship, though the rate of change in sediment should theoretically correlate with reservoir 

inflow or incoming sediment load.  

4.6 Turbidity Current 

On several trips, I noticed a distinct turbidity current which abruptly ended some distance 

from the mouth of the river. A photo of this is shown in Figure 4-19 and a map of the maximum 

extents is shown in Figure 4-17 and Figure 4-18. This turbidity plume was more pronounced at 

high flows and when the flow decreased, the plume shrank and moved upstream. The maps in 

Figure 4- and Figure 4- were created from continuously taking probe readings at a depth of ~1 m.  
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Figure 4-17: Probe Temperature Measurements 

 
Figure 4-18: Probe Turbidity Measurements 
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Figure 4-19: Looking Downstream at Study Area and Turbidity Current 

4.7 Phosphate Measurements 

Figure 4-20 shows the phosphate measurements from samples taken in the river and in 

the reservoir downstream from the survey area. In general, phosphate levels in the river were 

higher than the levels in the reservoir. There was also a general trend of decreasing reservoir 

phosphate and increasing river phosphate. 
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Figure 4-20: Lab Phosphate Measurements 

4.8 P Release Potential 

A detailed analysis of the P release potential is outside the scope of my research. In the 

section, I have attempted to determine the maximum amount of P that could be released to the 

water column from the DCR sediments in the small survey area. For this analysis, I made the 

following assumptions: 

 All new sediment is resuspended 

 All the water-soluble P is released with resuspension 
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 Dry sediment specific gravity is 2.65 

 Wet sediment specific gravity is 1.86 (30% porosity) 

With these assumptions, I calculated the total P that could be released using simple unit 

conversions. I also looked how this would increase the concentrations in a) the entire reservoir, 

and b) the upper reservoir near the survey area. This was then compared to the TMDL goals. 

These results are shown in Table 4-6 and 4-7.  

Table 4-6: Potential P Release (Original) 

 

 

 

Method: Diffusion

IDW, 1 

sector

IDW, 4 

sector offset Kriging

Natural 

Neighbors

Spline 

w/Tension

Fr.W+Fr.KCl concentration, mg P/kg dry sediment 9.19 9.19 9.19 9.19 9.19 9.19

Dry sediment specific gravity 2.65 2.65 2.65 2.65 2.65 2.65

Deposited sediment porosity 30% 30% 30% 30% 30% 30%

Deposited sediment specific gravity 1.86 1.86 1.86 1.86 1.86 1.86

Density of water, kg/m^3 1000 1000 1000 1000 1000 1000

P concentration, mg P/m^3 sediment 1.70E+04 1.70E+04 1.70E+04 1.70E+04 1.70E+04 1.70E+04

Volume of sediment, m^3 4700 6900 5100 7300 6900 8100

Potential P release, mg 8.01E+07 1.18E+08 8.69E+07 1.24E+08 1.18E+08 1.38E+08

Potential P release, kg 80 118 87 124 118 138

Total reservoir volume, m^3 1.81E+08 1.81E+08 1.81E+08 1.81E+08 1.81E+08 1.81E+08

Lower 2/3 volume, m^3 1.24E+08 1.24E+08 1.24E+08 1.24E+08 1.24E+08 1.24E+08

Upper 1/3 volume, m^3 5.72E+07 5.72E+07 5.72E+07 5.72E+07 5.72E+07 5.72E+07

Small survey area volume, m^3 6.09E+05 6.09E+05 6.09E+05 6.09E+05 6.09E+05 6.09E+05

Increase in concentration (total), mg/L 0.000 0.001 0.000 0.001 0.001 0.001

Increase in concentration (upper), mg/L 0.001 0.002 0.002 0.002 0.002 0.002

Increase in concentration (survey area), mg/L 0.131 0.193 0.143 0.204 0.193 0.227

TMDL Aug-Oct target P loading, kg/month 560 560 560 560 560 560

TMDL other months target P loading, kg/month 1513 1513 1513 1513 1513 1513

Percent of Aug-Oct TMDL 14% 21% 16% 22% 21% 25%

Percent of other months TMDL 5% 8% 6% 8% 8% 9%
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Table 4-7: P Release Potential (Adjusted) 

 

Method: Diffusion

IDW, 1 

sector

IDW, 4 

sector offset Kriging

Natural 

Neighbors

Spline 

w/Tension

Fr.W+Fr.KCl concentration, mg P/kg dry sediment 9.19 9.19 9.19 9.19 9.19 9.19

Dry sediment specific gravity 2.65 2.65 2.65 2.65 2.65 2.65

Deposited sediment porosity 30% 30% 30% 30% 30% 30%

Deposited sediment specific gravity 1.86 1.86 1.86 1.86 1.86 1.86

Density of water, kg/m^3 1000 1000 1000 1000 1000 1000

P concentration, mg P/m^3 sediment 1.70E+04 1.70E+04 1.70E+04 1.70E+04 1.70E+04 1.70E+04

Volume of sediment, m^3 10000 12600 9200 12500 11500 13700

Potential P release, mg 1.70E+08 2.15E+08 1.57E+08 2.13E+08 1.96E+08 2.34E+08

Potential P release, kg 170 215 157 213 196 234

Total reservoir volume, m^3 1.81E+08 1.81E+08 1.81E+08 1.81E+08 1.81E+08 1.81E+08

Lower 2/3 volume, m^3 1.24E+08 1.24E+08 1.24E+08 1.24E+08 1.24E+08 1.24E+08

Upper 1/3 volume, m^3 5.72E+07 5.72E+07 5.72E+07 5.72E+07 5.72E+07 5.72E+07

Small survey area volume, m^3 6.09E+05 6.09E+05 6.09E+05 6.09E+05 6.09E+05 6.09E+05

Increase in concentration (total), mg/L 0.001 0.001 0.001 0.001 0.001 0.001

Increase in concentration (upper), mg/L 0.003 0.004 0.003 0.004 0.003 0.004

Increase in concentration (survey area), mg/L 0.280 0.352 0.257 0.350 0.322 0.383

TMDL Aug-Oct target P loading, kg/month 560 560 560 560 560 560

TMDL other months target P loading, kg/month 1513 1513 1513 1513 1513 1513

Percent of Aug-Oct TMDL 30% 38% 28% 38% 35% 42%

Percent of other months TMDL 11% 14% 10% 14% 13% 15%



50 



51 

5 DISCUSSION 

5.1 Methods 

Over the course of this project, I learned a great deal about survey methods, sonar, 

phosphate, sediments, and GPS. From my experience, there are multiple sources of uncertainty 

in the methods used. I have identified what I believe are the major sources. These would be very 

difficult or impossible to quantify, but I have attempted to identify the two most significant: 

spatial location uncertainty and interpolation uncertainty.  

5.1.1 Spatial Location 

The uncertainty in the GPS position is ~1-2 m in X and Y, and ~3-4 m in Z. This makes 

our GPS unsuitable for measuring elevation. We assumed that the X and Y error was reasonable, 

but with a greater knowledge of the bathymetry, this could be a major source of error. Since the 

channel has steep side slopes, an error of 1-2 meters can cause a significant change in volume 

when a change doesn’t actually occur. Figure 5-1 below illustrates this problem. Both profile 

lines have identical elevation values, but the X location is shifted.  

A RTK GPS would solve both of these problems since it provides centimeter-level 

repeatable accuracy in three dimensions. We attempted to get a RTK GPS working with our 

sonar equipment, but could not get the GPS to transmit the location at a sufficiently high 

frequency. We used differentially corrected GPS for horizontal control which is accurate to 
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approximately 1-meter, well within the range of my horizontal interpolation error (see below). 

For vertical control we used the reservoir elevation to get approximate bottom elevations, and 

then adjusted each survey based on an area that did not change to provide consistency between 

the surveys. While the absolute elevation may not be accurate using this method, the change in 

bottom elevation (the important parameter) is improved.  

 

Figure 5-1: Spatial Location Error 

5.1.2 Interpolation 

Another source of uncertainty is the interpolation of the data points to a surface. This step 

is necessary to compute volumes. It is clear that the interpolated results to not always represent 

the bathymetry correctly, particularly near the channels. While I attempted to compare several 

interpolation methods, the lack of absolute ground-truth for evaluation prevented a robust 

analysis. There are also most likely interpolation errors due to features present at a scale smaller 

than the survey grids, but since I am interested in change, the errors should be of less importance. 

As noted, I do not have the data to support this statement. 
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These interpolation errors could be reduced by increasing the resolution of the survey. 

And while a tighter survey grid could reduce interpolation errors it would increase data 

collection and processing time.  

Single beam sonar equipment can be used to accurately measure bathymetry changes, but 

it works best for larger, simpler bathymetry features. Since the Provo River delta is very 

complex, single beam equipment simply cannot gather enough data in one day to accurately 

describe the bathymetry at the scale we are interested in. Ideally, this study would be performed 

with a multibeam sonar unit and RTK GPS. Multibeam sonar uses 100+ beams to map 

bathymetry on a line instead of at a single point. Typical multi-beam data sets have points 

measured on the order of inches (depending on the depth) in each horizontal direction. The result 

is a high resolution map with essentially zero interpolation error and greatly decreased data 

collection time. Multibeam sonar equipment has traditionally been very expensive, but prices are 

beginning to come down. If the costs decrease sufficiently to make a multibeam study feasible, 

this would be an ideal method for surveying the study area. An inexpensive multibeam system 

currently costs about $100,000.  

5.1.3 Other 

With the sonar data collected this year, an accurate bathymetry model can be created for 

use in a two dimensional water modeling software package like SMS. Analyzing the water 

velocities in the delta area with a 2D model would help in determining the locations where most 

of the scour likely occurs and aid in planning survey lines.  

As mentioned in section 2.3.1, we learned that the high frequency corresponds to the 

sediment surface, but we could not determine what the low frequency was reflecting off. 
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Consequently, we could not say that the difference between the two frequencies is the thickness 

of soft sediment. From looking at the thickness maps, it is clear that there is a difference and this 

difference varies spatially and temporally. However, we simply do not know if this means there 

is deposition/erosion, compaction, or some other process occurring. Professional surveyors use 

specialized sub-bottom profilers and sediment cores to accurately image beneath the soft 

sediment surface, but we do not have access to this equipment.  

We were worried about the effect of weeds, which at the upper end can grow to reach the 

water surface by the end of the summer. Our worries proved to be unfounded, as both the high 

and low frequencies easily penetrated the weeds. We did need to clean the propeller 

occasionally, but this was not much of a problem.  

5.1.4 General Discussion of Method 

With the uncertainties previously mentioned, single beam sonar does not seem to be a 

very useful tool for measuring sediment volume changes at Deer Creek Reservoir. While single 

beam sonar has been used previously to measure sediment changes, it is probably better suited 

for less complicated bathymetry and larger scales than found on DCR.  

In hindsight, it was a poor decision to survey a larger area with a larger grid. While there 

are interpolation errors for both the small and large survey grids, they are fairly consistent for the 

grid type. Changing survey plans introduced unnecessary errors. It would have been better to 

stick with the smaller grid since hanging survey plans introduced unnecessary errors. It also 

appears that a 15 m (50 ft) grid can provide reasonable accuracy for the DCR bathymetry, 

although at the expense of survey speed.  
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5.2 Results 

The results of this study are somewhat unexpected. We expected to see decreasing 

sediment volume in the upper end of the study area and increasing volume downstream. Instead, 

the overall volume increased.  In hindsight, this makes sense, as the entire upper third of Deer 

Creek is subject to deposition during spring flows. Our survey area is far enough in the reservoir 

to minimize bed load deposition, and suspended sediments settle over the entire area (as 

demonstrated by the visual and probe measurements of the turbidity plume). Normally, the WSE 

and discharge patterns are very different, but because of significant snowpack and a late spring, 

the discharge was very high and the reservoir remained nearly full for most of the summer. With 

a constant inflow and high water surface, continuous deposition would be expected. The high 

flows in June and July however likely had the effect of scouring sediments near the mouth and 

moving them downstream. This is visible in the profile plots.  

Had 2011 been a typical water year, I believe there would have been deposition in the 

spring and erosion in the summer as the reservoir was drawn down. As there was no drawdown, 

this did not occur. These data show a global increase in volume through the spring and summer 

with some local erosion near the river mouth. Without resuspension of sediments, no phosphorus 

would be released to the water column and algal growth would rely mainly on external nutrient 

sources. This is verified by the sample phosphate measurements which show decreasing 

phosphate levels downstream of the study area. If sediments are being deposited, they are likely 

sorbing and trapping phosphate and removing if from the water column.  

The field observations and probe measurements appear to confirm that the cold river 

water sinks suddenly below the warm reservoir water, potentially providing a current that could 

move sediment near the river mouth.  
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5.2.1 Influence on Algal Growth 

We were hoping to verify our conceptual understanding of the relationship between 

sedimentation, water surface elevation, and discharge by correlations between these values. 

Unfortunately, the methods used are simply not accurate enough to make definitive conclusions.  

If these sediments are resuspended during reservoir drawdown, we would expect to see 

the sediment volume decrease in the study area as water levels decrease. As reservoir drawdown 

creates a shallow depth across the survey area, the shear stresses should increase and create 

greater potential for resuspension and P release. However, since the reservoir was not drawn 

down as expected, this was not observed.  

As described in section 4.8, I estimated the potential amount of P that could be released is 

between 80 and 230 kg from the small survey area. I then used these valued to determine how 

this could change water column concentrations assuming the P was mixed in the entire reservoir, 

or limited to the area of resuspension (the upper third of the reservoir). These calculations 

showed that the concentration in the small survey area would increase by as much as 0.38 mg/L 

and the concentration in the entire reservoir would increase by 0.001 mg/L. Actual 

concentrations in smaller areas could be significantly higher, if the P is not mixed across the 

reservoir, but released local to the sediments. 

While these concentrations are not large, the range of P release from just the small survey 

area (80-234 kg) is 14-42% of the TMDL target for the late summer months. This is a significant 

amount as determined by the TMDL studies. 
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6 CONCLUSION  

As previously noted, this work is part of a larger study to understand and model water 

quality issues at DCR. This work will continue into the summer and in future years. A number of 

important inferences may be concluded from the work described in this paper. These deal 

primarily with the methods, but also with the results.  

6.1 Methods 

Over the course of this study, I learned a great deal about methods for this type of 

research. In this section I describe some of the things I’ve learned and make recommendations 

for future work in this area.  

First, it is important to have a well prepared survey plan based on previous field 

experience. Even the most well-thought-out plan can fail because existing field conditions were 

not considered. We had problems with our first several trips because the initial survey plan, 

which looked ideal in the office, proved very difficult to drive with the boat. Additionally, 

computer modeling of the water velocities would have provided a better estimate of how far 

downstream to extend the survey area.  

Second, the low frequency beam measurement cannot be relied on for accurate 

measurement of sediment thickness. More complicated equipment and sampling techniques are 

required to accurately characterize the sub-bottom material.  
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Third, the interpolation method chosen can have a significant impact on the results of the 

volume calculations. I found that ArcMap couldn’t always do a correct interpolation for the 

resolution I was trying to obtain. Other grid or TIN based methods will probably provide better 

results for the complex bathymetry of the Provo River delta.  

Fourth, having accurate position data in all dimensions (x, y, and z) is critical. Error in 

the horizontal position can have a much greater impact than I anticipated.  

Fifth, a fast computer and well organized GIS database can make analysis go quicker and 

easier. This also includes a consistent naming scheme and GIS tools to automate repetitive tasks.  

6.1.1 Recommendations for Future Work 

In this section I have listed several recommendations for future work based on my 

experience with this study.  

6.1.1.1 Improved Equipment 

When I began this study, I planned to use a high-resolution RTK surveying GPS to 

account for wave action and water level changes. For this approach to work, position updates 

need to be received at 10-20 Hz. I did not discover this until partway into the surveying season 

and could not determine how to achieve this with our equipment. While using a beam-difference 

method to calculate thickness should reduce or eliminate the need for this, more specialized 

equipment and software is needed. Future work could include RTK GPS or improved sub-bottom 

profiling. 

Ideally, this study would also be performed with a multibeam sonar unit. Multibeam 

sonar uses 100+ beams to map bathymetry on a line instead of at a single point. This results in a 

much higher resolution map for greatly decreased data collection time with zero interpolation. It 
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would also provide coverage in areas that would otherwise be inaccessible due to recreational 

use by other boats. Multibeam sonar equipment has traditionally been very expensive, but prices 

are beginning to drop. If the costs decrease sufficiently to make a multibeam study feasible, this 

would be an ideal method for surveying the study area.  

6.1.1.2 Revised Survey Extents and Resolution 

Future work should probably try to include a revised survey area in the survey, similar to 

Figure 6-1. This plan was not adopted initially because of the time required to survey such a 

large area and because we thought most of the change would occur in the main channel. Field 

experience and analysis of the results proved that we could drive the boat much faster than 

previously estimated, and that changes in sediment thickness were occurring more globally.  

Selecting the survey extents for the Provo River delta was difficult because the delta is 

non-traditional and not well defined. Two dimensional or three dimensional hydraulic modeling 

can provide further insights into sedimentation processes by looking into sediment transport and 

current velocities. These could be used to guide the selection of revised survey extents.  

If multibeam sonar is not used, I recommend spacing survey grid lines at 15 m (~50 ft) 

and focusing on the upper portion of the survey area. This fits within the turning radius of the 

boat and would provide sufficient coverage to properly define the bathymetry of the delta and 

channel.  
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Figure 6-1: Potential Revised Survey Extents 

6.2 Results 

We found that sediment movement did not align with our expectations. We thought the 

banks would remain a fairly constant depth and sediment movement would only be observed in 

channel. Since we observed changes outside the channel, this hypothesis appear to be flawed. 

However, some of these changes are likely due to interpolation errors.  

Lab phosphate measurements taken from water samples at the secchi depth showed that 

phosphate levels decreased after entering the reservoir, suggesting that sediment settling out of 

the water column trapped phosphate.  

Because the delta region experience deposition and little if any resuspension, we 

estimated the maximum potential P release that would occur if all of the new sediment was 

resuspended. This would lead to 80-230 kg of P release, or 14-42% of the TMDL.  
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6.3 Significance  

This work showed that P release from resuspended sediments is likely significant, 

particularly in the critical August-October time period. Sediment resuspension in the small 

survey area could account for as much as 42% of the TMDL specified for the late summer 

months. The changes in the methods described previously would be very helpful to improve 

accuracy. Further research is suggested to better understand and quantify these processes.  
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APPENDIX A: Detailed Sonar Operating Procedures 

A.1 Safety 

 Care should be taken when moving, attaching, or removing the transducer.  Two 

people should carry it to avoid injury and protect the equipment.   

 Care should be taken when attaching the GPS antenna to the transducer pole--do not 

drop the antenna in the water. 

 Do not survey if the waves become large or there is heavy rain. 

 When removing the laptop from the velcro mount on the boat, lift from then left side.  

This will prevent damage to the underside of the laptop.   

A.2 Equipment 

The equipment listed in Table A-1 is required for operation of the sonar.   

Table A-6-1: Equipment List 

ITEM PURPOSE PHOTO 

Panasonic 
Toughbook 
laptop with 
Hypack 2011, 
eChart, and 
hardlock usb 
key  

Operate sonar, 
record data, 
display progress, 
process results.  
Hardlock key 
required to run 
Hypack software. 
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Sonar 
transducer and 
boat 
attachment 

Send and receive 
sonar signal 

 

ODOM Echotrac 
CVM sonar box 

Connects 
transducer and 
computer.  
Processes signal 
and converts 
analog signal to 
digital.   
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Cables for sonar 
and GPS 

Connect 
everything 
together. 

 

Other Equipment 

ODOM Digibar 
Pro with data 
recorder 

Record sound 
velocity profiles.  
Optional.  
Depends on depth 
of survey and 
accuracy required.  

 

A.3 Hypack 

The Hypack quickstart guide and YouTube videos (available at www.hypack.com) are 

very useful for learning how the software works.    

A.4 Data Collection 

The basic process for data collection is shown below in Figure A-1.  A detailed 

description of each step follows. 

http://www.hypack.com/
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Figure A-6-2: Data Collection Steps 

A.4.1 Attach Sonar 

 Attach the transducer pole to the starboard side (right when facing forward) with the 

transducer facing forward.  The pole should be installed on land and kept in a 

horizontal position until ready to survey. 

 Attach safety cable to cleat.   

A.4.2 Connect Cables 

 Connect the GPS antenna to the CVM with the yellow cable.   

 Connect the transducer cable to the CVM.   

 Plug in the LAN cable.  

 Insert the PC card adapter into the laptop and connect to the ports on the CVM.  Use 

the extension cables to avoid damaging the PC card adapter.  

o GPS I/O(A)Port A 

o GPS OUT(B)Port B 

o DEPTH I/OPort C 

 Attach the laptop power cable to the plug on the CVM and plug the CVM into the 

power outlet near the driver.   

 Rotate the transducer into the water.   

 Start the generator and power on the CVM.  

A.4.3 Test Hardware 

 Open eChart and choose Connect  

 Start Hypack (remember the hardlock key) and open the project file, if not already 

loaded.   

 Open the hardware page (  ), select the GPS, and choose "Test".  Select File>Test 

All.  Make sure the GPS is returning positions and the sonar returns two readings.  

Adjust the gain and power in eChart if needed so the correct return is identified as the 

bottom.  

Attach Sonar 
Connect 
Cables 

Test Hardware 
Perform 
Survey 

Measure 
Sound Velocity 
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A.4.4 Perform Survey 

 Open survey (  ).  A map will be displayed with the current location and 

planned lines. 

 Select the display windows that you want.  The Data Display, Depth, Map, Left/Right 

Indicator, and Trimble DSM 232 windows are recommended.  

 When near the start of the first line, choose Record in eChart. 

 Start at the lower end of the survey area.  The corner of the boat should pass through 

the start gate circle to start logging.  If you miss the start gate, go back and start again 

or use the onscreen controls to manually start the survey.  If needed, you can 

increment or decrement the current line, or switch directions using the controls in the 

survey window (see Figure A-2).   

 After the boat crosses the perpendicular end plane, logging will end and the next line 

will be selected.   

 Drive at a slow, (4-6 mph) constant speed and stay within one boat width of the 

planned line.   

 Keep an eye on the depth graph to make sure the correct signal return is being 

digitized.   

 After the last line is finished, choose Stop Recording in eChart and close Survey.  

This will take a while as the data is compiled. 

 

 

 

Figure A-6-3: Hypack Survey Window 
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A.4.5 Measure Sound Velocity Profile 

 At the deepest part of the survey area, lower the Digibar and record the sound 

velocity every 1 ft.   

 See Digibar manual for more details.   

A.5 Processing 

Figure A-3 shows an outline of the processing steps.  A description of each step follows.  

For more details about processing in Hypack, see www.hypack.com.  The YouTube videos are 

particularly helpful.   

 

 

Figure A-6-4: Hypack Processing Steps 

A.5.1 Sound Velocity File 

 Connect the Digibar handheld to the computer and open the Digibar software 

 Select Download Cast and choose the cast you want 

 Check to make sure you downloaded the correct file (look at the date field) 

 Remove any bad measurements (usually at top or bottom) 

 Click Export and change the file type to Hypack Vel files.  Save the file in the Hypack 

project folder. Include the measurement date in the filename.  

 Open Hypack.  Right-click on Sound Velocity Files in the table of contents and 

choose Import.  Select the appropriate file.  

A.5.2 Edit Raw Data 

Soundings are recorded as *.RAW files which contain the raw sounding data for each 

planned line.  A *.LOG file is a catalog of the raw data surveyed on that day.  To do anything 

Import Sound 
Velocity File 

Edit Raw Data Save XYZ File 

http://www.hypack.com/
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with the data, you need to have edited data (*.EDT) files.  The goal of this step is to remove 

spikes or other bad data.   

 Open the Single Beam Editor (  icon or Processing>Single Beam Editor). 

 Open the log file for the day you want to edit.  Catalog files are named with the date 

of the survey.   

 Select the individual files you want to edit.  Typically you should choose ―select all‖.   

 Select the sound velocity file for the survey date and enter ―1524‖ as the echosounder 

SV setting. 

 Choose the ―use both‖ option and click ok 

 Read Parameters window: 

o Make sure the correct devices are selected 

o Select the presort options you want.  Usually “Yes, all data” and 

―Distance along line‖ is appropriate.  Choose an increment for the presort 

method selected.  The Selection option should be “Average Depth”. 

o The other parameters should not be changed 

 Make sure the Profile window is open.  You can also open the survey window if 

desired.   

 Choose Edit>Merge Corrections 

 Choose Edit>Search and Filter Options  

o Set the Min Depth to a small number, usually 1.0  

o Set the Spike Limit to 1.0 and the Gate Step to 3.0 

o Set Apply Min/Max Filter to Corrected Depth 

o Choose Basis as Depth 1 and Depth 2 

o You can experiment with these options as needed 

 Choose Edit>Filter All to remove points outside the filter gate 

 Go through each line and check for spikes missed by the filter and remove them 

manually with the eraser  

 Smooth the depths  for all lines.  Typically 32 samples works well, but you may 

need to adjust this depending on the Presort settings. 

 If there is a bad line, choose File>Ignore Current Line  

 When finished, save the files 

A.5.3 Export Edited Data 

 Open Final Products>Export 

 Right-click on the edited file you want to export and choose Enable. 

 Select User Defined from the combo box and choose options. 

 Under User Defined Output, check Date, X, Y, Latitude (WGS84), 

Longitude(WGS84), Corrected Depth 1, and Corrected Depth 2. 

 Click OK, specify a location/file name, and choose Export 
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A.5.4 Further Processing 

 Open the XYZ file in Notepad and add a line at the top with ―x,y,z‖.  This creates the 

field names for the data.   

 Replace the double spaces with commas and save as a *.txt file.   

 Open the file in your preferred program (ArcGIS, AutoCAD, SMS, etc) for 

interpolation and volume calculations.  

 Alternately, you can process the data in Hypack.   

 


